
 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 بسم الله الرحمن الرحيم 



 

 NavisWorksخلال تلك الدبلومة سيتم شرح برنامج الــ 

 

 ؟  NavisWorks× في البداية ما هو برنامج الـ 

ومصنف من شعبة  AutoDESKوهو عبارة عن برنامج من إنتاج شركة 

أنه حيث   "BIM " Building Information Modelingبرامج تكنولوجيا الـ 

من حيث  Primaveraبرنامج يقوم بكل المهام التي يقوم بها برنامج  

 Revitوبعض مهام برنامج الـ  جدولة الانشطة والجدول الزمني ...الخ 

 كما انه يقوم بعمل كلًا من الأتي:

1- Time Liner. 

2- Quantification. 

3- Clash Detection. 

4- Render. 

5- Animation. 

سميات السابقة سيتم شرحها بشكل تفصيلي خلال تلك مكل تلك ال

لا يقوم بعمل   Navisworksمراعاة ان برنامج الـ   عم الدبلومة

Modeling or Simulation .للمشاريع المختلفة 

                                                                                                          

 

 أيمن أشرف البستاويم. 

 



 

 Install of Program –تسطيب البرنامج 
 في البداية سنقوم بفك ضغط ملف البرنامج ومن ثم نقوم بتسطيب البرنامج بشكل طبيعي. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 . Installبعد الأنتهاء من تلك الخطوة نقوم بالضغط علي 

ومن ثم الضغط علي   I Acceptبعد الانتهاء من الخطوة السابقة بقوم بالضغط علي  

Next . 

 

 

 

 

 

 

 

 

 

 

 Serial Number & Productبعد الانتهاء من تلك الخطوة نقوم بادخال كلاً من الـ 

Key . 



 

- Serial Number = 066-66666666 

- Product Key = 507H1 

 ملحوظة: 

 . فقط NavisWorks 2016تلك البيانات خاصة فقط بتسطيب نسخة 

 .Nextبعد تلك الخطوة نقوم بالضغط علي 

 

 

 

 

 

 

 

 

 

 

بعد تلك الخطوة نقوم بتطسيب البرنامج بشكل كلي وننتظر حتي الانتهاء من تسطيبه بشكل  

 كامل.

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

بعد تلك الخطوة نكون قد انتهينا من تسطيب البرنامج بشكل كلي وباقي خطوة واحدة فقط الا  

 ". في حالة البرنامج مش نازل من الموقع الرسمي" وهي خطوة تفعيل البرنامج 

 . Activation Codeنقوم في تلك الخطوة بادخال كود التفعيل الـ 

 



 

 

 

 

 

 

 

 

 

 

 

وادخاله في خانة الـ   Request Codeللـ  Copyوتتم تلك الخطوة عن طريق عمل 

Request   في الكراك أو الكيجين أو الباتش المخصص بتفعيل البرنامج ومن ثم نقوم

ونقوم بأخذ الارقام والحروف الموجودة   Patchثم الضغط   Generateبالضغط علي الـ  

 Activation Codeووضعها في خانة الـ    Copyبأمر   Activationفي خانة الـ 

from Autodesk تفعيل البرنامج بشكل كلي    وبذلك نكون قد انتهينا من تسطيب و

 ومدي الحياة. 

 

 ملحوظة: 

الكمبيوتر "   –ــ يفضل عن تسطيب البرنامج ايقاف حماية الجهاز المستخدم " اللاب توب 

 مع مراعاه عدم تفعيل الانترنت. 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 سنبدأ بيها شرح الدبلومة. وهذا هو شكل البرنامج والواجهة الرئيسية وهي ما 

في البداية سنفهم الفرق بين كلاً من البرامج الأتية حيث ان تلك البرامج تظهر عند تسطيب  

 البرنامج: 



 

 

 

 

 

 

1. Navisworks Manage: 

وهو البرنامج الشامل لكل أوامر البرنامج والتي من خلالها نستطيع استخدام البرنامج  

 بشكل كامل وأفضل. 

 

2. Navisworks Simulate: 

 . Clash Detectionولكنه لا يستطيع عمل الـ  Manageوهو نفس الـ 

 

3. Navisworks Freedom: 

وهو برنامج خاص فقط برؤية المشروع ولا يقوم بأي عمل ولا يقوم بحفظ ولا استخدام  

 الملفات.

لأنه الأعم   Navisworks Manageخلال تلك الدبلومة سنقوم بالعمل علي الـ  

 والأشمل. 

 

 :Navisworks× أمتدادات برنامج الـ 

 أمتدادات مختلفة:  3ويشمل البرنامج علي 

- NWC: "Navis.Works.Cache" وهو امتداد ملفات التصدير من برنامج الريفيت .                        

- NWD: " Navis.Works.Model"                      وتلك صيغة اخري لملفات البرنامج الصادرة منه  

بحيث ان دي الصيغة اللي بتناسب البرنامج لنفسه   وهي اخر صيغة بطلعها من البرنامج.                           

- NWF: " Navis.Works.File"                         وهو الملف السابق اللي بتقدر تحط عليها تعليقات .  

عشان المشاريع اللي بنشتغل عليها عادة بتكون طالعة ومتصدرة من برنامج   NWCعادة احنا بنشتغل علي صيغة الـ  

 الريفيت وتتم تلك الخطوة كالتالي:

 : Navisworksإلي برنامج الـ   Revit× كيفية التصدير من برنامج الـ 



 

ولابد وان  Revit   &Navisworksوتتم تلك الخطوة في حالة تحميل وتسطيب كلا من برنامجي 

  2016يكونوا من نفس السنة ليسهل التصدير مباشرة كما سنري اي بمعني كلا البرنامجي يكونوا سنة 

 المهم يكونوا نفس السنة الاصدار.  2020أو  2017أو 

 تي: ــ ويتم التصدير من خلال الا

Add-Ins > External Tool > Navisworks 2016 

 

 

 

ومن ثم نقوم بفتح برنامج الـ  NWCخلال تلك الخطوة نكون قد حددنا امتداد الملف الا وهو الـ  

Navisworks   ونقوم بفتحه علي البرنامج من قائمةOpen . 

وبذلك نكون قادرين علي استخدام كل مميزات   Revitوبذلك قد تم استيراد الملف المراد من برنامج الـ 

 التي ستيم شرحها خلال الدبلومة باستفاضة تامة.  Navisworksبرنامج الـ 



 

فهي تستخدم في حاله وجود اي تعديل علي  Navisworks Switchback 2016بالنسبة لـ  

مرة اخري مع مراعاة ان الامتداد للملف   Revitوعايز ارجعه برنامج الـ  Navisworksبرنامج الـ 

  .NWFالمحفوظ هو  

 

 

 

 

 × ملحوظة:

ولكن  RVTويمكن أيضا استيراد ملفات الريفيت   DWG & DXFــ نستطيع استيراد ملفات الاتوكاد 

لأن من خلالها نستطيع   NWCالأفضل هو التصدير كما فعلنا سابقا اي من برنامج الريفيت بصيغة الـ  

 –الخاصة بالمنشأ " البلاطات  Categoryالتحكم في المنشأ بشكل أفضل أما بالمناسيب أو بالـ 

 ، ويمكن تحديد تلك الفرق بينهم من خلال التصدير من قائمة الـ   السلالم ...إلخ " –الكمرات  –الأعمدة 

Navisworks Settings . 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 وتتم من خلال: 

File Reader > Revit 

 ومن خلال تلك الجزئية كنا 

 Divide Fileمحددين الـ 

Into Level : 

 ودي بتعني ان المشروع

 اتصدر بالمناسيب وليس ال ـ

Category  عايز ولو

 اصدر 

بلغي   Categoryبالـ 

 تفعيل 

 . Check Mark الـ

 

 ويتم ذلك من خلال ال ـ  Navisworksــ هناك أمر أخر يتم من خلاله إضافة مشروع في برنامج الـ 

Append & Merge 

 

 

 

 

وتستخدم في حالة اضافة أكتر من منشأ في منشأ واحد ويتم ذلك لمعرفة التعارضات في برنامج الـ  

Navisworks  أو ما يعرف بـClash Detection   حيث ان من المعروف ان اي منشأ يتكون من

ويتم استخدام تلك الخاصية   "MEP"عدة لوحات منها المعمارية والأنشائية والميكانيكية والكهربية 

 في البرنامج لوضع أكتر من لوحة ومن ثم معرفه التعارضات بين الاقسام الهندسية وبعضها البعض. 

 

 

 

 



 

 :Navisworks× مكونات واجهة المستخدم في برنامج الـ 

 يتكون البرنامج من: 

- Menu Browser: 

 – Openمثل   ونستخدمهم لفتح الملفات

New … etc . 

Save & Save As & Export 

ونستخدمهم لحفظ الملفات والتصدير المنشأ  

 لباقي البرامج المختلفة أو حفظه.

 

- Quick Access Tool Bar: 

 

وفيه بعض اختصارات و الأوامر 

 & New & Openالمستخدمة بكثرة كـ 

Save & Print & Undo & Redo 

& Refresh . 

 

 



 

- Menu Bar " Tab Bar": 

 

 

وكل واحده تتكون من  Panelsويتكون هذا من  Ribbonمن اللي فوق تتكون من   Tabكل 

Buttons & Icons. 
        

 

-  Navigation Cube & Bar: 

ويستخدم هذا المكعب للتحكم في مجال رؤية المنشأ من أكتر  

من زاوية رؤية سواء من اتجاه الشمال أو الجنوب أو الشرق  

وأيضا التحكم في حرجات السير والتحرك داخل   أو الغرب

 المنشأ كما هو موضح في شرح الفيديوهات.

 



 

ويتم ذلك من  Mouseفي البرنامج من خلال الـ   Modelــ بالنسبة للتحكم في المنشأ كـ 

 . Panوالضغط عليه للتحكم في الـ  Zoom in & Outللتحكم في الـ  Scroll Wheelخلال 

 

يتم ذلك   Revitكما كان في برنامج الـ  Navisــ بالنسبة لتعديل وضع الرؤية في برنامج الـ 

 من خلال: 

Viewpoint > Render Style > Mode 

 



 

  .Viewبرنامج يتم من خلال قائمة  الــ وللتحكم بشكل أفضل في الرؤية في  

ومنها ايضاً إظهار   Workplaneحيث من خلال تلك القائمة نستطيع اظهار ما هوا مساعد في الـ  

 ومنه العديد من التفاصيل.  Revitوإخفاء المحاور المستوردة من برنامج الـ 

 

 Navisفي برنامج الـ  Selection - التحديد 

هي امكانية تحديد اي   Navisمن أفضل المميزات والخصائص التي يتميز بها برنامج الـ 

 عنصر بدقة عالية وبأكتر من طريقة ويتم ذلك من خلال الأتي: 

- Selection Tree: 
  Revitالخاصة ببرنامج الـ   Categoryأو الـ  Levelsويتم ذلك من خلال التحكم علي حسب الـ 

 من خلال اعداد التصدير من البداية ومن خلالها نستطيع التحكم وتحديد كافة العناصر المرسومة.

 

 . Pinعن طريق الـ  Workplaneفي الـ   Selection Treeويمكن تثبيت الـ 

 



 

 من خلال:  Selection Treeيمكن أيضاً إظهار الـ  ــ

View > Workspace > Windows 

الواحدة   Workspaceويمكن أيضا من خلال تلك القائمة إضافة العديد من الوجهات في الـ 

ويمكن فتحه   Save Workspaceمن خلال   وأيضا نستطيع حفظها للاستخدام مرة أخري

 . Load Workspaceمرة أخرى من خلال الـ 

 

 

 

 

 

 

 

 

 



 

- Selection By Select All & None & Invert: 

تحديد المنشأ بشكل كامل كما هو موضح بالصورة وبالنسبة  Select Allحيث من خلال الـ  

 Invertأو كل المنشأ وبالنسبة لأمر ويستخدم للألغاء تحديد شئ ما  Select Noneللـ 

Selection أو بمعني أخر ممكن أستخدمه لتحديد كل  فدا بيعكس التحديد اللي كنت محدده

 ر اللي أنا محددها.العناصر ماعدا العناص

 

- Selection By Select Same: 

في    Select All Instanceفي الاتوكاد أو الـ  Select Similarودي حاجة كدا زي الـ 

زي   ودي بقي بتتكون من حاجات كتير جدا علي حسب أنت عايز تحدد بناءً علي ايه  الريفيت

 مثلاً:

Same – Type – Material – Element – Level …etc 

 

 

 



 

- Selection By Sets: 

انك من خلال الخاصية دي تحط مثلا قطاعات القواعد    Groupودي بالظبط عامله زي الـ 

معين وبالمثل مع أي عنصر انشائي موجود ودا بيتم من المسحلة في جروب واحد بأسم 

 خلال الأتي: 

Select The Element > Manage Sets > Save Selection 

خاص بقطاعات الأعمدة اللي في زاوية واحدة من  Groupعلي سبيل المثال عايز أعمل  

 المنشأ:

 . البداية وأخر في النهايةويمكن أيضا التحكم في أولوية الجروبات من خلال جعل جروب في  

 

 

 

 

 

 



 

 Navisأخفاء العناصر في برنامج الـ  

 يتم التحكم في إخفاء وإظهار عناصر المنشأ من خلال:

Home > Visibility 

- Hide: 

 وتستخدم في إخفاء اي عنصر تم تحديده.

- Require: 

 .Selection Treeوتستخدم عندما نريد تظليل اي عنصر في الـ 

-  Hide Unselected: 

 في حالة اخفاء عناصر غير محددة.  وتستخدم

- Unhide all & Unrequire all: 

في حالة لو عايز ارجع كل حاجة كما كانت أو اظهار كافة العناصر التي تم   وتستخدم

 اخفاءها من قبل. 

 



 

 Navisطريقة البحث عن العناصر في الـ 

 .Find Itemsويتم ذلك من خلال 

 

Time Liner 

وهو عبارة عن محاكاة زمنية لمراحل تنفيذ المشروع كالذي يستخدم في برنامج الـ  

Primavera :ويتم الحصول عليه من خلال 

Home > Tools > Time Liner 

 

 

 



 

 من أربع أيقونات رئيسية: Time Linerويتكون الـ  

1-  Task: 

ومن خلالها يتم إضافة الأنشطة ومنها أيضاً يتم تعريف مراحل المشروع المختلفة ويتم ذلك  

 . "Add Task" من خلال 

 ملحوظة: ×

 ". Gaint Chartهذه الواجهة مقسمة لجزئين " الأنشطة وتعريفها" و " الـ 

 

 :ومن خلال هذا الجدول يتم ادخال بعض البياناتــ 

ومن خلاله بيطلب نوع هذا   Task Typeكأسم النشاط ، بداية ونهاية مدة هذا النشاط ، 

 .النشاط سوا نشاط تشييد أو هدم أو نشاط مؤقت

 

 



 

 :Attachــ بالنسبة لـ 

ودي بتعتبر أهم خطوة لأن من خلالها بنستطيع تحديد النشاط ويتم ذلك من خلال تحديد 

 ومنها تخصيص النشاط.  Attachعلي خانة الـ  Right Clickالنشاط المراد ومن ثم 

 من خلال الأتي:  Attachويمكن عمل الـ 

Attach Current Selection: 

 ومن خلالها يتم تخصيص العنصر المحدد.

Attach Current Search: 

 عن طريق محركات البحث.ومن خلالها يتم تخصيص العنصر 

Attach Sets: 

 عن طريق المجموعات التي تم شرحها سابقاً. ومن خلالها يتم تخصيص العنصر 

 

 

 

 



 

2-  Data Sourses: 

ودي طريقة بتوفر عليك مجهود انك تحط كل نشاط لوحدة وممكن تستورد شيت أكسيل  

 .Primaveraكامل فيه كل التفاصيل أو ممكن تستورد الشيت اللي طالع من برنامج الـ  

 

3- Configure: 

 ودي بتكون خاصة بالشكل والجرافيك الخاص بالإخراج بتاع الأنشطة. 

 Appearanceويمكن التحكم أكثر في درجة الألوان وشفافيتها من قائمة الـ   

Definations . 



 

 . Simulateمع مراعاة ان اي لو يتم اختيارة هيظهر بلونه الذي تم اختيار في قائمة الـ 

 

4-  Simulate: 

 مسبقاً. ومن خلال تلك القائمة نستطيع اظهار فيديو للمنشأ بالانشطة التي تم جدولتها 

 . Settingويمكن التحكم والتعديل في الفيديو من خلال قائمة 

 

 

 



 

- Start & End: 

وهم بداية ونهاية الفيديو للمنشأ والبرنامج بيكون  

اللي انت كنت معرفهم من   Tasksمعرفهم من خلال الـ  

البداية ، ويمكن أيضا التحكم في تاريخ البداية والنهاية  

 . Overrideخلال الـ  أيضا من خلاله ويتم ذلك من

 

- Interval Size: 

ودي من خلالها بنستطيع التعامل مع النشاط كفترات  

 زمنية اما عن طريق الساعات او الاسابيع او السنين. 

 

- Playback Duration: 

 ودي من خلالها بنستطيع التحكم في سرعة الفيديو. 

 

- Overlay Text: 

ومن خلالها نستطيع التحكم في لون وحجم والكتابة اللي  

بتظهر والفيديو شغال في الجهة الشمال من الـ  

Workspace . 

- Animation: 

 بفيديو أنا كنت مسجلة قبل كدا.  Time Linerودي من خلالها بستطيع ربط الـ 

 

- View: 

لإيه بالظبط من خلال الانشطة بالتواريخ   Simulateبيسألك في النقطة دي أنت عايز تعمل 

 اللي كنت مجهزها. 

 

 

 × ملحوظة:
لعدد من  "WBS " Work Breakdown Structureــ في حالة لو عايز أعمل الـ 

 . Indentالأنشطة يتم ذلك من خلال تحديد الأنشطة الأول ثم بعد ذلك نختار 

 

 



 

 

 × ملحوظة:
 Auto-Addــ هناك طريقة لتسهيل إضافة الانشطة مرة واحدة وتسمي هذه الطريقة بـ  

Task  .ومنها يتم إضافه الانشطة مرة واحدة مع فرض توقيت لكل نشاط 

 



 

 :Data Soursesبالنسبة لجزئية الـ 
ودي المستخدمة بكثر في الشركات حيث من خلالها نستطيع ان تستورد شيتات لجدولة 

 . Excel or Primavera or Ms Projectالمشروع من برنامج الـ 

 . Addويتم ذلك من خلال 

- CVS: "MS – DOS" 
أو بمعني أخر دي صيغة الشيت اللي من المفروض تحفظ   Excelدي خاصة ببرنامج الـ 

 الملف عليها عشان البرنامج يقدر يفهمه. 

- Microsoft Project: 
 . MS Projectودي خاصة بالملف الصادر من برنامج الـ  

- Primavera P6: 
 . Primaveraودي الخاصة ببرنامج الـ  

 

 Excelالتصدير لبرنامج الـ 
 : Export to Scheduleويتم ذلك من خلال 

 . Excel or Ms Projectومن خلالها نستطيع شيت لبرنامج 



 

Simulate with Video 
 علي شكل فيديو للمنشأ. Simulateبالنسبة لإخراج جدول زمني موجود الـ  ــ 

هنعمل من الـ   Simulateيتم ذلك أولاً من تسجيل فيديو للمشروع ثم بعد ذلك من جزء الـ  

Setting   ومنها هنختارAnimation  ونحددSaved Viewpoints Animation. 

 

 من خلال:  Navisــ يتم تسجيل الفيديوهات في برنامج الـ  

Animation Tab > Create > Record 

 يظهر كما كان في الفيديو المسجل.  Simulateوعندها عند اخراج الـ 

 

 . Export Animationيتم ذلك من خلال ايقونة  ــ ولتصدير هذا الفيديو كملف 

 

 

 

 

 

 

 

 

 

 ومن خلال تلك القائمة نستطيع التحكم في جودة الملف المُصدر. 

 حيث من خلال الآتي: 



 

- Source: 

أو الـ    Time Linerمن خلالها نستطيع تحديد تصدير الفيديو فقط أم تحديد الـ 

Quantification   .إلخ... 

- Render: 

تلك الخاصية تمكن لدي المستخدم من اخراج الفيديو بشكل شبه طبيعي اما عن طريق 

 . Autodeskالبرنامج أو من خلال موقع شركة 

- Output: 

أو من خلال إخراج فيديو عن طريق    Jpeg or Pngإخراج الفيديو أما عن طريق صور  

Avi . 

- Size: 

 من خلالها نستطيع التحكم في جودة وإخراج الفيديو. 

- FPS: 

 للفيديو أو تتابع الصور.  Frame/Secمن خلالها نستطيع التحكم في الـ 

- Anti-aliasing: 

 من خلالها نستطيع التحكم في سرعة الفيديو. 

 

 

 

 

 

 

 



 

 Quantification  –الحصر 
 من خلال ال ـ Navisيتم الحصر في برنامج الـ  

Home Tab > Tools > Quantification 

سيظهر واجهة أخري معرف فيها بعض  Project Setupبعد تلك الخطوة سنضغط علي 

 شيتات الحصر من البرنامج:

وذلك في حالة عايز   Noneفبنتخار الـ 

شيت حصر انت اللي تخرجه بشكل اللي  

 . Nextتحتاجه ثم بعد ذلك نختار 

 

 

 

 

 



 

من خلال تلك القائمة بحدد نوع الوحدة المستخدمة في اخراج شيت الحصر أما بالـ  

Imperial   ودي الخاصة بالـFeet & Inch    أو من خلال الـMetric  ودي الوحدات

 طن العربي. المستخدمة في مصر ودول الو 

  ومنها نؤكد علي الوحدات.  Nextــ بعد تلك الخطوة نضغط علي  

ثم بعد تلك الخطوة سنحدد كامل المشروع من خلال    Finishثم بعد تلك الخطوة نضغط علي  

 Modelالتي تم شرحها من قبل ثم بعد الخطوة نقوم بالضغط علي الـ   Selectionطرق الـ 

Takeoff . 



 

 لتي تم حصرها في البرنامج نتبع الأتي: ولإظهار العناصر ا

ومن ثم تغير  Viewpointمن خلال قائمة   Shadedيتم أولاً تغير وضع الرؤية إلي   -1

 . Modeوضع الرؤية من 

 .Quantificationمن نافذة الـ  Show Takeoffالضغط علي   -2



 

بلون مميز ولو عايز تتأكد أنه حصر كل العناصر اضغط   Categoryسنري أنه ملون كل  

لو اختفي المنشأ ككل فدا يعني أن المنشأ كدا مظبوط ومفهيوش اي   Hide Takeoffعلي 

مشاكل في الحصر الخاص به ولو فيه أي عناصر كانت موجودة فهذا يعني أن فيه عناصر  

 لم يتم حصرها بعد. 



 

د الحصر كمان كان في موديل الريفيت من خلال  ويمكن أيضا الرجوع في تلوين المنشأ بع

 نفسها حيث:   Quantificationنافذة الـ 

- Reapply Quantification Appearance: 

 نستطيع من خلالها اظهار الالوان. 

- Reapply Original Model Appearance: 

 نستطيع من خلالها اظهار ألوان الريفيت. 

 

 .Excelالي برنامج الـ  Navisبالنسبة بقي لتصدير الشيت من برنامج الـ × 

 . Export Quantitiesويتم ذلك من خلال ايقونة الـ 

 

 Export Quantities toومنها نختار 

Excel.  

 



 

وبرنامج الـ   Revitوصف تفصيلي لكل عنصر انشائي تم رسمه في برنامج الـ 

Navisworks . 

لكل   Minusوالضغط علي علامة الـ  Items Pivot Tableوللوصف البسيط يتم فتح 

 عنصر. 



 

أفضل بكثير من  Navisمن الواضح ان اخراج شيتات الحصر من برنامج الـ 

وذلك بسبب قدرته علي اخراج شيتات الحصر كلها مرة واحدة   Revitبرنامج الـ 

 غير برنامج الريفيت. 

 

 



 

 ×ملحوظة:

 .Categoryما سبق كان اخراج ملفات الحصر للمنشأ عن طريق الـ 

 

 . Levelsبالنسبة بقي للإخراج شيتات حصر للمنشأ عن طريق الـ 

 

 . Navisماسبق كان الشيت بناءاً علي المناسيب المصدرة من برنامج الريفيت لبرنامج الـ  



 

 × ملحوظة:

 .NWD or NWFيتم الحفظ بأحدي الصيغتي  Navisعند حفظ الملفات من برنامج الـ 

 

 

 

 

 

 

 

 

 

 

 



 

 Detectionh sCla –التعارضات 
 في بداية الأمر كدا تعالوا نفهم يعني ايه مصطلح التعارضات؟!

من المعروف ان أي منشأ في الوجود لازم يتكون من العديد من اللوحات الخاصة بالأقسام 

الهندسية المختلفة مثل اللوحات المعمارية يليها اللوحات الانشائية يليها لوحات مهندسي 

 و بمعني اخر اي مشروع لازم يدخل فيه كلا من:ميكانيكا وكهربا والصحية أ

Archetict – Civil Engineer – Mechanical – Electrical – Plumping 

فمن المتوقع حدوث تعارضات بين كلاً من اللوحات المختلفة أي بين لوحات المعماري  

 ولوحات الانشائي أو لوحات الانشائي ولوحات مهندسي ميكانيكا ...الخ. 

 

  Navisworksك من أفضل البرامج المستخدمة في تحديد التعارضات هو برنامج الـ ــ ولذل

 من خلال:  Revitويمكن عمل أيضاً كشف التعارضات علي برنامج الـ 

Collaborate > Coordinate > Interference Check 

 Revitلأنه يعطي دقة وحلول أكتر من برنامج الـ  Navisولكن يفضل الـ 

 



 

 يتم ذلك من خلال:   Navisكتشاف التعارضات في برنامج الـ بالنسبة لإ

Home > Tools > Clash Detective 

المختلفة   هندسيةعشان نستخدم بقي موضوع التعارضات دا لازم الأول نضيف اللواحات ال 

 . Appendويتم إضافتها من خلال أيقونة الـ 

 

حيث أنه بيعمل دمج للمشروع الانشائي من نظيره من المشاريع الاخري وخلال تلك 

وذلك لوجود تفاصيل كثيرة   MEPالدبلومة هنشتغل علي مشروع انشائي مع مشاريع الـ 

 .فيها



 

ولوحات ميكانيكية وهنشوف التعارضات بين  هيكون معانا لوحات انشائية ولوحات كهربية 

 تلك اللوحات وبعضها البعض. 

 .Navisworksــ في البداية هنفتح لوحة الأنشائي علي برنامج الـ  

بدون تقسيم المناسيب وبالمثل   Revitوخلال هذا المنشأ سيتم تصديره من برنامج الـ 

 هنعمل كدا مع اللوحات الميكانيكية والكهربية. 

 

   Appendوهنضيف اللوحات الكهربية ومرة أخري Appendتلك الخطوة هنعمل   ــ  بعد

 هضيف من خلالها اللوحات المكانيكية. 

 

 



 

 

 وبذلك نكون قد أضفنا اللوحات الانشائية مع اللوحات الكهربية مع اللوحات المكيانيكية

وللمعلومة موضوع التعارضات بيوفر عليا المشاكل اللي بتحصل في الموقع أثناء التنفيذ  

خاصة في مثل تلك المشاريع وذلك لوجود تعارضات كثيرة بين لوحات الانشائي والميكانيكا 

كما سنري خلال الكشف   Ductوالكهرباء مثل تعارض قطاع عمود مع فتحة أو ما يسمي بـ  

 علي العيوب. 



 

 . Clash Detectiveعد تلك الخطوة نقوم بالضغط علي ــ ب

 

ومنها بشوف هل هيكون فيه تعارضات  Add Testبعد تلك الخطوة سنقوم بالضغط علي 

 ولا لا. 

ثم بعد ذلك نقوم بضبط الاعدادات وتجهيز اللوحات لعمل  Testبعد تلك الخطوة نقوم بإضافة 

 بحث التعارضات. 

 

 

 

 



 

  Clash Detectionثم بعد الخطوة السابقة سنقوم بتحديد اللوحات اللي هنعمل ما بينها 

 وعلي سبيل المثال هنبدأ باللوحات الكهربية واللوحات الميكانيكية.

 : Selectionبالنسبة للأيقونات الموجودة أعلي الـ 

- Rules : 

أقسام كما هو   4رضات وتنقسم لـ  ودي القوانين والقواعد اللي من خلالها ممكن أهمل جزء من التعا

 موضح بالشكل: 

 . Newونستطيع عمل قاعدة أو قانون جديد من خلال قائمة 

 

 



 

 

- Select : 

 ودي من خلالها بقدر أحدد اللوحات اللي هعمل ما بينها تعارض كما هو موضح. 

 

 

 



 

- Result : 

 ومن خلالها نستطيع اظهار النتايج الخاصة بالتعارضات. 

 

- Result : 

 خلالها نستطيع إخراج شيت كامل بالتعارضات ودي بتكون أخر خطوة في المشروع.ومن 

 

 



 

 ــ بالنسبة لهذا الشريط: 

 

- Add Test: 

 جديد. Checkومن خلالها نستطيع إضافة 

- Reset All: 

 بيرجع كل حاجة لأصلها أو كما كانت. 

- Compact All: 

 بيعمل دمج. 

- Delete All: 

 . Testsبيمسح الـ 

- Update All: 

 . Testsودا بيحدث الـ  Testودا بيظهر في حالة وجود أكثر من 

 

 

 

 بالنسبة لتلك الايقونات تستخدم كالتالي: 

": وتستخدم في الكشف عن التداخلات والتعارضات من خلال Surfaces× أولأً من جهة اليسار "

 الأسطح الخاصة بالاجسام المُحددة.

 

 الكشف عن التداخلات والتعارضات من خلال تداخل الخطوط.": وتستخدم في Lines× ثانياً " 

 

": وتستخدم للكشف عن التعارضات من خلال النقاط المتداخلة والمشتركة خلال Points× ثالثاً "

 الجسمين. 



 

": وتستخدم في حالة تقاطع مجسم مع نظيره أو مع نفسه أو في حالة  Self - Intersect× رابعاً "

 وجوده بشكل متكرر.

 

 Selection": وتستخدم لتحديد عنصر انشائي مثلا من قائمة Use Current Selectionخامساً "× 

 علي سبيل المثال قطاعات الاعمدة من خلال القائمة أعلاه. 

 

 نفسها.  Workspace": وتستخدم لتحديد العنصر من الـ Select in Scene× سادساً "

 

 اللي هيتعمل وبيتكون من:  Testفدي خصائص الـ   Settingوبالنسبة لجزء الـ 

- Type: 

  4ودي من خلالها بقدر أحدد نوع التداخل أو التصادم وبينقسم لـ  

 أنواع: 

Hard: 

 ودي بتعني وجود تداخل أو تصادم بين جسمين صلبين. 

Hard ( Conservative ): 

 . Hardوتعني ان مش شرط ان الجسمين متداخلين ممكن يكونوا مشتركين في نقطة وهو أقوي من الـ  

Clearance: 

ويستخدم في حالة وجود خلوص أو مسافة بين جسمين وانا مش عايز المسافة دي تقل عن قيمة  

 معينة. 

 

 



 

Duplicates: 

 وتستخدم في حالة تداخل بين عناصر مكررة. 

 

- Tolerance: 

 من خلالها بضيف نسبة أو قيمة السماحية في التداخل. ودي 

- Link: 

 ودي بتتكون من حاجتين:

None & Time Liner  ودي من خلالها بقدر أشوف التعارضات بين المدة الزمنية

ومن خلالها بضيف    Stepsللأنشطة والجدول الزمني وأيضا حين تفعيلها يفُعل معها الـ 

 حصل تعارض في الجدول الزمني. وقت أو مدة التداخل اللي بعدها ي

 

 واظهار التعارضات. Testلحل الـ  Run Testوفي النهاية نضغط علي 

 



 

لا   Resultsبين اللوحات الكهربية والميكانيكية وعند النظر في الـ  Testوما سبق كان أو 

 .الميكانيكاوهذا يدل أنه لا يوجد تعارضات بين لوحات الكهرباء ولوحات    Clashesيوجد 

 أخر بين لوحات الأنشائي ولوحات الميكانيكا.  Testممكن دلوقتي نعمل 

 للمشروع.  Run Testوبنفس الخطوات السابقة مع عمل 

 

 

 



 

 خلال الكشف عن التعارضات. Clash 214ظهر  Run Testبعد عمل الـ 

بالاسفل كما هو ويمكن إظهار التعارض بين اي عنصر واخر من خلال تحديده والنزول 

 موضح: 

 



 

في   Ductبين البلاكة الخرسانية في لوحة الأنشائي والفتحة  Clashوكما هو متوقع هناك 

 لوحة الميكانيكا. 

 

 يتم كالتالي: hessClaبالنسبة للتحكم في شكل وعرض الـ × 

 وبعضها البعض عن طريق تحديدها.  Clashesــ يتم التنقل بين الـ 

 يتم ذلك من خلال:  Clashesبالنسبة للتحكم في الوان واخراج شكل الـ 

Highlightning: 

ومن خلالها اما ان نظهر الألوان أم لا ولتغير اللون المستخدم يتم ذلك  

 من خلال: 

Menu Browser > Option > Tools > Clash Detective 

 

 التحكم في الالوان المستخدمة.  Custom Highlight Colorsومن خلال 

 



 

 

 

 

 

من خلال الحالة التي تم   Clashesفمن خلاله نستطيع إظهار ألوان الـ   Itemبالنسبة للشريط أسفل الـ 

وتنقسم الي عدة  Clashتحديد التعارض عليها ولمعرفة تلك الحالات توجد في أعمدة كل تعارض 

 أعمدة.

 تختلف علي حسب الأوان كما هو موضح بالشكل:   Statusحيث الـ 

 الأخضر.باللون   Approvedباللون الأحمر والـ  Newحيث لكل حالة لون فعلي سبيل المثال الـ 

 

لا تظهر الا في حالة تم تغيير وضعية الرؤية التي  Clashــ بالنسبة للكاميرا التي تظهر بجانب كل  

 . Clashيظهر بها الـ  

 



 

 بالنسبة لهذا الشريط: 

- New Group: 

 و وضعه في جروب واحد وبالمثل مع الايقونة التي بجانبه.  Clashمن خلالها نستطيع تحديد أكثر من 

- Remove From Group: 

 أو اكثر من الجروب.  Clashوتستخدم لإخراج 

- Explode Group: 

 ومن خلالها نستطيع تفجير وفك الجروب.

- Assign: 

عندما يكون هذا التعارض معتمد من مهندس أو استشاري بيوقع   Approvedونستخدمها في حالة الـ  

 عليه أو بيحمل المسؤلية لشخص معين. 

- No Assign: 

 عكس ما قبلها. هي 

- Add Comment: 

 . Clashفي حالة أردنا إضافة أي تعليق علي الـ  

- None or Exclusive or Inclusive: 

 ومن خلالها نستطيع التحكم في عرض التعارضات. 

- Reset & Compact: 

 .  Resolveلهااللي اتعمل  Clashesأو بنعمل مسح للـ   Clashesومنها أما بنضغط الـ 

- Re-Run Test: 

 مرة أخري.  Clashesومنها بنعمل إعادة تشغيل وإخراج الـ 

 

 

 



 

 : Display Settingsبالنسبة لباقي قائمة الـ 

- Isolation: 

 ودي بتتكون من حاجتين:
Dim  ودي بتعني انك هتظهر الـClashes  وباقي المنشأ   بشكل واضح

 بتاعته قليلة.  Opacityأو الـ  Half Toneبيظهر كما كان 

 فبيخفي باقي المنشأ وبيظهر بس التعارضات.  Hideأما الـ 

- Viewpoint: 
 Animation Transitionالاخر من خلال الـ  Clashومن خلالها نستطيع التحكم في شكل التوجه للـ 

 . Auto-Loadالي  Auto-Updateوتحويل الـ 

 

 . Clashesــ ماسبق يتعبر أهم الخصائص الخاصة بالـ 

 

 ×ملاحظات: 

عن طريق تحديد عناصر انشائية في   Clash Detectionيمكن عمل  -1

 لوحات هندسية وليس شرطا تحديد اللوحة الانشائية كاملة.

وذلك في حالة أردنا تعديل   Revitيمكن الرجوع مرة أخري لبرنامج الـ   -2

 .Switchbackويتم ذلك من خلال الـ  hessClaبعض الـ 

 

 

 

 

 

 

 

 

 

 



 

 hessReport of Cla –تقرير التعارضات 

من أهم التقارير الواجب تواجدها عند التنفيذ الا وهي تقاير التعارضات ولكي نخرج تقرير  

ومن ثم تجهيز   Reportيتم ذلك من خلال قائمة الـ   Navisبالتعارضات من برنامج الـ 

 . Write Reportومن ثم  HTMLالتقرير علي صيغة 



 

 



 

 



 

 

 . Clash Detection –وبذلك نكون أنهينا جزء التعارضات 



 

Extra Tools in Navis 

 وهي ما سنتحدث عنها.  Reviewتلك الأوامر موجودة في قائمة 

 

- First. Measure Panel: 
1. Measure: 

 وهي العنصر الخاص بالقياس ويتكون من عدة عناصر مختلفة كما هو موضح. 

وحدات القياس من خلال: لكن أولاً يمكن تغيير   

Menu Browser > Interface > Display Units 

من خلالها تحديد أي وحدة تريد استخدامها او القياس بها سواء بالمتر أو  

 الميللي أو البوصة أو القدم ... الخ. 

 

 



 

 . Measureومن خلالها نستطيع استخدام اي عنصر من عناصر قائمة 

- Point to Point: 

 ومن خلالها يتم الحصول علي بعد عن طريق تحديد نقطتين. 

- Point to Multiple Point: 

 تسخدم للحصول علي القياس من خلال عمل أمتر من نقطة. و

 

 

 

 

 

 

 

 

 



 

- Point Line: 

 ولكنه يهتم بالنقطة القادمة.تقريباً مثل الأمر السابق 

- Accumulate: 

 ودا بيجمع المسافات اللي انت اخدت منه الأبعاد.

- Angle: 



 

 ومن خلالها نستطيع حساب الزاوية بين ضلعين أو عنصرين. 

- Area: 

 ومنها يتم حساب المساحة.

- Clear: 



 

 وتستخدم لحذف جميع الأبعاد المرسومة. 

- Lock: 

 بعد معين فقط. ويستخدم لتقييد الحركة في 

 

 



 

- Shortest Distance: 

وينشط هذا الأمر من خلال تحديد عنصرين انشائيين وهذا الأمر بيحسب أقصر مسافة 

 بينهم. 

- Convert to Redline: 

 . Clearومن خلالها يتم تحويل البعد للون الأحمر وأيضاً ثابت لا يمُسح بالـ 

- Text: 

لكتابة أمر معين مع مراعاة أن هذا الأمر يتم كتابة منه أي شئ ولكن يختفي مع تحريك 

 المجسم ولإظهاره يتم ذلك من خلال:

View > Windows > Saved Viewpoints 

 

 

 

 



 

يتم اظهار الكتابة في المكان الذي كتبت فيه ولعمل كتابة في مكان  Viewمن خلال هذا الـ 

 Colorمع امكانية تغيير اللون وسمك الخط المستخدم من  اخر   Viewاخر يلزم أيضا عمل  

Thickness . 

 



 

 

- Draw: 

في حالة وجود أخطاء في   Revision Cloudمن خلال نستطيع رسم اشياء مختلفة منها الـ 

 اللوحات. 

 



 

- Erase: 

  Selection Windowوتستخدم في حذف ما تم كتابته أو رسمه ويتم ذلك من خلال عمل 

 يحيط بكامل الشكل. 

 

- Add Tag: 

حيث  Textومن خلالها يتم إضافة أي تعليق علي أي جزء في المنشأ مع نفس فكرة الـ 

 Viewيتم إظهار من خلال الـ   Commentمختلف وأيضا لإظهار التعليق  Viewيظهر في 

Comments . 

 

 ولحفظ ما تم إضافته يتم ذلك من خلال:   Reviewوبذلك نكون أنتهينا بشكل كامل من قائمة  

Save as > NWF or NWD 



 

عشان  Mergeثم  Appendوبعد ذلك هنفتح المشروع مرة أخري ثم بعد ذلك هضغط علي 

  هخلي المشروعين عبارة عن مشروع واحد.

 

 ×ملحوظة: 

 . Item Toolاخري وتسمي بـ   Tabعند تحديد اي عنصر موجود يظهر 

من خلال تلك القائمة يمكن التحكم في حركة العنصر من حيث تحريك أو تكبير وتصغير أو  

 .Reviewكما هو موجود في قائمة  Viewمن خلال دوران العنصر ولكن كل ذلك كـ  



 

ولإظهاره لابد من تغيير وضع الرؤية لـ   Colorــ يمكن تغيير لون العنصر أيضاً من جزء الـ 

Shaded . 

 

للعنصر من خلال تحديده ومن ثم تغيير الـ   Opacityــ يمكن أيضاً تغيير الـ 

Transperancy  ولإعادة وضع الرؤية كمان كان يتم ذلك من خلال الـReset 

Appearance . 

 

 

 

 

 وبذلك نكون قد أنتهينا من دبلومة ال ـ

Naviswork 

أو  أ او تقصير كان من خط "ما كان من توفيق فمن الله وما

 ني ومن الشيطان"فمن ياأو نسذلل 

 

 تنسونا من صالح دعائكم لا
 

 أيمن أشرف البستاوي م. 

 


